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1 General approach 

International Language Services (ILS) follows The Chicago Manual of Style. Seventeenth edition (CMOS), 
for most questions of style and format. Where necessary to accommodate the conventions of different 
academic disciplines and different varieties of English, flexibility is allowed. For questions of style 
beyond the scope of this style sheet, please consult CMOS. View a print copy or ask your GPS supervisor 
for permission to access the online version and go to Chicagomanualofstyle.org Use of a different style 
sheet will be granted only in consultation with the GPS Director of Content Services. 

1.1 Communication with the author 

The GPS project editor initiates correspondence with the author. The goal is to develop a cordial 
relationship, with a rapid exchange of editor questions and suggestions, and author corrections. 

An initial letter may request an abstract (in some cases) and metadata. Metadata includes the subject 
language (using ISO code), the dialect name (if applicable), the manuscript content language (with ISO) if 
not English, the script name (if non-roman type), the country name (any country involved), and up to 
eight key words used for Internet searches. 

In a second letter the editor may propose breaking the manuscript into logical units (for long 
manuscripts), and negotiate how to comment and make corrections: The editor might correct simple 
punctuation and grammar errors without comment but works with the author on all content issues. The 
editor can suggest alternate wording for unclear content or leave that to the author. Throughout the 
process the editor assures the author that GPS wants to serve both the author and reader by producing a 
polished, professional publication. 

Along with a list of comments, the editor sends a current PDF to the author for reference but, to 
avoid multiple edited documents, retains the Word document—so that changes are implemented by the 
editor. 

1.2 Content editing 

The following are suggested steps to follow in the editing process: First, if the manuscript already has a 
table of contents (TOC), use it to get an overview. Second, skim the manuscript for a general 
understanding of the content. Third, read the work carefully and address the following factors: 
• Cohesion: All parts lead to the intended conclusion, and at each level, all parts are parallel. 
• Clarity: Where unclear, in a marginal comment, the editor suggests an alternative wording or simply 

notifies the author of what portion is unclear. 
• Conciseness: Sentences are complete but not too long or too choppy. Needless repetition can be 

reworded or eliminated. Detail that is not central can be footnoted or deleted. The editor makes 
suggestions but the author decides on final wording. 

• Consistency: Section topics follow the order forecasted in the introduction. Numbering, citation, 
references, and all internal information and conventions are consistent. 

• Culturally appropriate: Choice of vocabulary is inoffensive. Mention of religious affiliation and 
persuasion is as minimal as possible. 

1.3 Copy editing 

The goal of copy editing is to improve the grammar, spelling, and punctuation—and conform the 
manuscript to ILS standards for the front matter, text, and end matter. This style sheet and appendices 
are organized according to the progression in which a copy editor addresses them in the sequential 
process of editing a manuscript. By following the Appendix E checklist an editor can verify that the most 
important points were covered in the editing process.

https://www.chicagomanualofstyle.org/home.html
https://www.chicagomanualofstyle.org/home.html
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1.4 Compositing 

The author or GPS specialists apply the SIL template to the manuscript, converting all styles to the SIL 
template norms. If editors have compositing experience, they will check and correct formatting issues. 
They, and the final GPS compositors, follow the SIL template electronic styles guidelines and definitions 
illustrated in Appendices A and B. There the template styles are referred to by their style name in italics, 
e.g., SIL Para 1—the style name for the first of two body text paragraph styles. 

One of the final steps for compositors is to generate a TOC from the final version. 

2 Headers and footers 

The area at the top of a page is the header and the area at the bottom of a page is the footer. This section 
briefly explains the use of header and footer texts that occupy those areas. See Appendix B.2 to see how 
styles are used to format these upper and lower zones. Papers and books have different norms. 

Headers, also called running heads, appear above the text, and (running) footers appear below the 
text. In print books they include the book title and page numbers, and in some books they include 
chapter names. Pagination appears as footers for the first page of each new part (e.g., abbreviations, 
contents, references) and chapter but as headers in all other contexts. For papers pagination appears at 
top right for all pages, and no header title is given. GPS compositors will style the headers and footers. 
• Pagination guidelines for different types of books are found at Appendix B.2. 
• The front matter in books is paginated with lowercase roman numerals (i, ii, iii, etc.). The page 

count starts on the title page, a right hand recto page. The reverse of this page is called verso. The 
title page and its verso page do not show headers or footers. 

• The central text paginates with arabic numerals and starts counting with “1” after the front matter 
for books, and with the title page for papers. Papers often paginate using only arabic numerals. 

• For books the first marked page of central text will be a recto, odd numbered page. This page 
number occurs as a footer. Major parts of the book, including all chapters, begin on a recto page, 
and show page numbering as a footer. All other pagination is given as headers. For papers, the first 
page showing numbering is either page 2 or 3, and all pagination appears flush right, as a header. 

• Throughout the work, blank pages are counted but do not receive a printed number or header. 
• Page numbers do not appear at the back of monographs, where other SIL publications are listed. 

3 Front matter 

A work can be divided into three divisions: front matter, text, and end matter. Front matter is discussed 
here in section 3, a discussion of text begins in section 4, and end matter is discussed in sections 11 
and 12. 

Much of the front matter is generated by the compositor and so will not be described here in detail. 
This division of a manuscript includes the title page and, optionally, other parts, like the abstract, 
abbreviations, and TOC. Book-length works will have a verso page and may include a foreword, preface, 
and acknowledgments. For more about front matter, see examples in Appendices A and B.3. 
• The title page includes title and subtitle, author, publisher, year, and copyright information. 
• The title and subtitle are headline capitalized, i.e., the first word and all subsequent words except 

prepositions, articles and conjunctions are capitalized. All-caps text is not used in titles or subtitles. 
For style names, see examples in Appendix A. 

• The table of contents, simply entitled Contents, is part of the front matter. Generally only two or 
three levels are given in the contents. It is given a page number for books, but not included in many 
of the electronic paper series. It may be followed by an abbreviations list, acknowledgments, a 
foreword, and/or a preface before the central text begins. It is generated by the GPS compositor
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4 Text 

The central text of the manuscript consists of different heading, paragraph, and list types, each with 
format applied by selecting styles in the SIL template styles panel. See examples in Appendix A. 

4.1 Headings and titles 

Headings (as opposed to headers—see section 2) mark major parts or sections within the text. Parts 
include the abstract, abbreviations, acknowledgments, and contents; other major section breaks include 
chapter titles and level headings. Part titles are not numbered; chapter titles and level headings are. 
Headings and titles do not use all capital letters. Vernacular words are italicized in non-italic headings 
and are in non-italic type in third- and fourth-level headings, which are italicized. 

4.1.1 Part headings, chapter titles, and level one headings 

Headings and titles are formatted differently for print books and electronic books and papers, and are 
described here separately. See examples in Appendices A.1 and A.2. 

Print books 

• Part headings (abstract, contents, appendices, references, etc.) in print books are centered and 
headline capitalized, i.e., the first word and all subsequent words except prepositions, articles, and 
conjunctions are capitalized. 

• Chapter titles for print books are also centered and headline capitalized; the chapter number is 
entered manually and is given immediately above the title using a no-break space. See Appendix 
A.1. 

• Level one headings for print books are also centered, but they are sentence capitalized, with only 
the first letter of the first word of the title captitalized. 

• If the headings of print books are numbered, they are numbered manually. The sequence restarts 
with each chapter and includes the chapter numeral, e.g., heading 1 of chapter 1 is 1.1; heading 1 
of chapter 2 is 2.1. No punctuation follows either the number or heading text. A tab separates the 
number from the text. For examples, see 4.1 and 4.1.1, above. 

• Collections, which have a different author for each chapter, give the author’s name, then the 
abstract for the chapter beneath the title. 

E-Books and papers 

• Part headings and chapter titles are headline capitalized; level headings are sentence capitalized.  
• Part headings, chapter titles, and level headings are all flush left.  
• E-Book headings may be numbered like print books. Alternatively, they may be numbered like 

papers, which don’t include a chapter number either to the left of, or above, the heading. 
• Headings and chapter titles are not followed by closing punctuation. 

4.1.2 Second, third, and fourth level headings 

• Level two headings and all lower level headings are sentence capitalized and positioned flush left. 
See Appendix A.2. As with first level headings the subheading number is followed by a tab and then 
the heading title, with no period following either the number or the heading text. 

• Headings lower than the fourth level are rarely used. 



4  ILS Publications Style Sheet 
 

 
 

4.2 Paragraph styles 

All normal text is in 10 pt, Charis SIL font. There are two main paragraph styles and the block quotation 
style used by ILS, as illustrated here. See also A.3. The first paragraph of text occurs as the first 
paragraph following titles, headings and subheadings. It is not indented, as shown in this paragraph. 

All subsequent paragraphs are first-line indented, as shown in this paragraph. No line space 
occurs between paragraphs. 

A block quotation contains four or more lines of quoted text. It is set off from the rest of the text. 
For information about formatting block quotations, see A.3. Second and succeeding block quote 
paragraphs appear as illustrated below. The citation information within parentheses in a block quotation 
comes after the sentence final punctuation, as shown in this example, taken from CMOS: 

Block quotations, which are not enclosed in quotation marks…are further distinguished from the 
surrounding text by being indented…or set in smaller type [than] the text…. 

Length is usually the deciding factor.… Other criteria apply, however. A quotation of two or 
more paragraphs is best set off, as are quoted correspondence, lists, and any material that requires 
special formatting. If many quotations of varying length occur close together…it may be better to 
set them all as block quotations, however short. (2010:623) 

4.3 Bulleted lists, example lists, and item lists 

• Bulleted lists are for unordered items. See examples at Appendix A.5. 
• Numbered lists are of two types. See Appendix A.5. 
(1) List examples are typically used for language examples and are normally flush left. The numbering 

occurs within parentheses, as shown by this example number. These are numbered sequentially 
throughout the work. However examples in appendices are normally numbered separately. In the 
text, example numbers are referred to as (2), (2a), (2a, b), (2a–c), etc. 

1. List items include an item number or letter (or combination of the two) at three hierarchical levels. 

4.4 Citation and parenthetic information 

• Citations are given within parentheses and include the author’s last name, year of publication and 
page number(s), with a colon separating year and page number(s). No space occurs following the 
colon, as in (Fillmore 1968:248, 251). If you refer to an author in the text, only the date and page 
are enclosed in parentheses, as in “Looney (1987:34) claimed that flamingos are the greatest bird 
ever.” 

• The abbreviation et al. may be used in the text for the citation of multiple authors, e.g., (Wonderly 
et al. 1996), but et al. is not used in the reference entries. See also 12.1.1. 

• When short-length quotations occur within surrounding text, the citation follows the close-quotation 
mark, but is followed by the sentence closing punctuation, e.g., “this is the end of a short quotation” 
(Fillmore 1968:248). 

• Parenthetic information added by the author or editor is identified by enclosing a phrase in 
square brackets within the quotation or within the parentheses of the citation. For example, 
(Longacre 2013:23 [emphasis added]). 

4.5 Footnotes 

Footnotes appear at the bottom of the text area of the page. They are preferred over endnotes. The text 
of long footnotes may be carried over to the bottom of the following page. If so, the footnote continues 
in the middle of a sentence so the reader knows that the footnote has not ended. 
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• To insert a footnote use the toolbar (ribbon): References tab; Insert Footnote. In the text, footnote 
reference numbers are superscript and placed after the word or after adjacent punctuation and non-
alpha characters. 

• Footnotes do not appear in part headings. A note that refers to the book or article as a whole is 
unnumbered and marked with a symbol rather than number, e.g., an asterisk, and precede the 
numbered notes. The asterisk is also used to mark a single footnote in an article. 

• Footnote numbering starts at the beginning of each chapter with “1.” 
• Footnotes are removed by deleting the note referent from the text. The actual footnote text is 

automatically removed from the bottom of the page. 
• The number of footnote lines on each page should be balanced. Avoid very long footnotes and a 

large number of footnotes, if possible. Also avoid interlinear examples in footnotes when possible. 
• Footnotes for tables and figures, i.e., table notes, appear at the bottom of the table or figure. See 

section 10 and Appendix A.6.2. 

5 Punctuation 

5.1 Quotation marks 

• Double quotation marks are used to signal direct speech quotation, e.g., John said, “I am coming,” 
or a word-for-word citation from literary sources. Single quotation marks are acceptable if used 
consistently by an author who prefers European spelling and punctuation standards. 

• Quotation marks used as scare quotes signal nonstandard use of a term such as slang, jargon, irony, 
or rhetorical effect. 

• When a word or term is not used functionally but is referred to as the word or term itself, it is either 
italicized or enclosed in double quotation marks, e.g., superstar is a term of reference for people who 
are highly acclaimed. When used to highlight a word for effect, the first usage is marked by italics; 
following occurences of the same word are not marked. Quotation marks may be preferable to 
italics when there are a significant amount of vernacular examples—which also appear in italics in 
the manuscript. Whether in italics or with double quotes, use consistently within the manuscript. 

• Double quotation marks are used in the text to set apart titles of articles, plays, papers, chapters, 
poetry, dissertations; in the references, quotation marks are not used for this purpose. 

• Curly quotation marks, also called smart quotes, are preferred over straight quotation marks—which 
are reserved for technical use, e.g., the abbreviated measurement symbols for inches (″) and feet (′). 

• The closing double quotation mark should normally follow any other adjacent punctuation mark, 
e.g., “Watch out!” he exclaimed, or “I’ll see you later.” 

• Translated terms, with a focus on the word in English, are marked by double quotes rather than 
with single quotes, as a gloss, e.g., the term for “father” [is] attyi. 

• Single quotation marks enclose a gloss. See also section 9.2. However, in a table where gloss is 
listed, quotation marks are unnecessary. The close-quotation mark for textual glosses should 
precede any other adjacent punctuation mark, e.g., achen ‘person, people’. A second example shows 
the gloss mid sentence: the assertion karyong ami ‘it is true’, came into widespread use. 

5.2 Commas 

• Commas normally separate items in a series. When a conjunction joins the last two elements in a 
series, a comma should appear before the conjunction. But, if done consistently and spelling follows 
European conventions, commas may be omitted preceding the conjunction. 

• Likewise, different conventions for use of commas may be followed. For example, although in 
American English a comma normally follows i.e. and e.g., a European author may not use a comma. 
Use the appropriate convention for the author’s country, applied consistently in that work. 
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5.3 Ellipses and spacing 

Ellipses mark a continuation of a thought that may span textual clauses, sentences, even paragraphs. It 
is used to link salient information and eliminate what is extraneous. 
• Use ellipses sparingly. At the beginning of a quotation an ellipsis is not needed. 
• Ellipses generally occur with no space between the ellipsis and the text. However, when the ellipsis 

represents a span of multiple sentences, a period and space follow the ellipsis mark. If an ellipsis 
occurs at the end of a line, break after the ellipsis by inserting a space before the following text. 

• Spacing, using the space bar, never exceeds one space insertion; even sentence final punctuation 
(periods and colons) are followed by only one space. 

• Tab insertion is used for indentation and longer spacing. Like single-space insertion, tabs are 
inserted to separate example numbers from text, and for language data—to separate columns for 
interlinear text in the creation of tables. 

5.4 Hyphens, em dash, and en dash 

Symbols for em dash and en dash can be inserted in the text from the ribbon by selecting the Insert tab; 
Symbol; More Symbols; Special Characters. 

5.4.1 Hyphens 

Hyphenation should be kept to a minimum. Editors avoid word hyphenation at the end of lines.  
• End-of-line hyphens are appropriate in these cases: 

• When hyphenation marks compound adjectives that occur naturally at end of a line, e.g., a book-
length article is preferred reading for this assignment. 

• Although editors avoid use of hyphens, compositors can break a word at the end of a line at the 
end of a syllable containing three or more letters. A word break should not be used if less than 
three letters of a word either end or begin a line. 

• Hyphens are used between numbers that are not inclusive, e.g., ISBNs, Library of Congress numbers, 
and telephone numbers. In contrast, en dashes adjoin successive numbers. See section 5.4.3. 

• In interlinear text, hyphens signal morpheme-affix breaks. For other linguistic use, follow Crystal.1 

5.4.2 Em dash 

Em dashes are often used in the text instead of commas, parentheses, or colons, e.g., “My friends—David 
and Jane—came to see me.” No spaces occur between the em dash and an adjacent word. If a word or 
number break occurs at the end of a line, break after the em dash, not before it. 
• If the work is written in European style, an en dash – with one space on either side, as shown in this 

sentence – may be used in place of an em dash. 

5.4.3 En dash 

The en dash generally adjoins successive or inclusive numbers. These typically mark a page number 
sequence, e.g., 71–72, or a date sequence, e.g., August 1–4. 
• The en dash is marked with no spacing on either side. However, for European use, when used in 

place of an em dash, spacing does occur. See an example at 5.4.2. 

                                                   
1 Crystal, David. 2008. A Dictionary of Linguistics and Phonetics. Sixth edition. Oxford: Blackwell Publishing. 
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6 Numbers, numerals, dates, and spelling 

• Most numbers that can be expressed in one or two words are spelled out, whether exact or 
approximate (see exceptions below). This includes numbers from one through one hundred, and all 
round numbers above one hundred that require no more than two words or compound words, e.g., 
sixty thousand, sixty-two thousand, or forty-five million.  

• Numerals are used for numbers above one hundred requiring three words, e.g., 101, 310, and for a 
sequence of numbers, as in pages for citations or a year sequence in references. When giving the 
sequence include all the digits of the second number, e.g., 95–96, not 95–6. For an exception to the 
inclusive numbering standard, see CMOS 9.61. 

• Express percentages as a numeral and spell out the word percent. The percent symbol (%) and 
numerals may be used in tables (or in the text when refering to numerals in a table), on business 
forms, when parenthetic, in references, and in statistical or technical material. 

• Numerals are also used in mathematical expressions, e.g., a frequency of 1 in 18, and for 
measurements, as in fractions used for technical purposes, e.g., 3/16ths of an inch. For other 
possible usage of numerals see CMOS 9.14 and 9.15. 

• Dates may be given according to either American English or European English style, as long as used 
consistently within a work, e.g., Febuary 23, 2019 (American), or 23 February 2019 (European). 

• Spelling conventions for either American English or European English can be used, as long as only 
that convention is used consistently within the book or article. 

7 Italics, bolding, and underlining 

Italics, bolding, and underlining are used for emphasis, but are used sparingly. 
• Use italics for titles of books, journals, and conference proceedings in the text. Use regular (non-

italic) type with double quotation marks around titles of articles, chapters, or sections in the text. 
See also section 5.1. 

• Another common use of italic type is for vernacular in academic publication—which is typically 
italic. 

• Underlining, in general, is used only for emphasis of vernacular text. 

8 Capitalization, abbreviation, and acronyms 

8.1 Capitalization of titles 

• Standards for capitalization of headings and titles are given in section 4.1.1. 
• In the text, headline capitalize titles of books, journals, articles, and chapters. In headline 

capitalization, all words are capitalized except articles, conjunctions, and prepositions (no matter 
how long), unless used adverbially or as an adjective. 

• Do not capitalize the terms chapter, section, chart, figure, map, or table in the text when cross 
referencing. 

8.2 Abbreviations 

• In parenthetical references, terms like chapter, section, and figure can be abbreviated (see ch. 2, sec. 
4, fig. 2.6); reference numbers are given as numerals. 

• In the text, names of biblical books are generally spelled out, e.g, Genesis 2:3. In parenthetical 
references, those names may be abbreviated, typically without a period, as in (see Gen 2:3). For a 
list of standard biblical references, see CMOS 10.45-47. 
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• The abbreviation etc. is not used frequently and does not occur following e.g. or for example. 

8.3 Acronyms and abbreviation with full and small caps 

8.3.1 Full caps 

• Linguistic abbreviations for technical terms: SVO (subject-verb-object), CVC (consonant-vowel-
consonant), NP (noun phrase), VP (verb phrase), PF (phonological form), etc.—except when this 
abbreviation is used in interlinear text glossing (see Small caps, below). 

• Acronyms for organizations or agencies, such as SIL International, IBM, and MIT. 
• University degrees, such as PhD, DMin, MD, and MA. 
• In reference lists, other lists, and mailing addresses, states, territories, and possessions of the  

US are abbreviated using full-cap two-letter postal codes. See CMOS, section 10.27 for the codes. 

8.3.2 Full or small caps 

• Either full or small caps can be used for language name abbreviations, e.g., QZ or QZ, for 
Quiegolani Zapotec (Mexico). 

• A combination of both full caps (initial letter) and small caps is used, e.g., CONT-INT, SPREAD. 

8.3.3 Small caps 

• To highlight a technical term in the first instance of its use in the text, e.g., the term MORPHEME. 
Regular type should be used for subsequent occurrences of the term. 

• Technical terms for some grammatical categories, like image schema, is given in small caps, e.g., 
IN/OUT CONTAINER. The diminished-size type is applied using the style SIL Chr Technical. 

• Abbreviations in interlinear text glosses, e.g., PL (plural), SG (singular), M (masculine), 
F (feminine). 

• For time reference, e.g., A.D., B.C., A.M. and P.M. (lowercased a.m. and p.m. are also acceptable). 

9 Vernacular, glosses, and interlinear text 

Vernacular is italicized to distinguish it from the text language of communication. However, in tables the 
vernacular is not italicized. In general, text is not underlined for emphasis, however in vernacular 
examples a word or morpheme may sometimes be underlined for focus. 

9.1 Vernacular, IPA script, and biblical languages 

• Vernacular words in the text are italicized, e.g., mari mari ‘hello’, in Mapudungun (Chile), except 
when the vernacular occurs within phonetic brackets [maři maři] or phonemic slashes /mari mari/. 

• Vernacular words in tables and interlinear text are not italicized (unless needed to distinguish them 
from surrounding text). 

• Proper nouns in the vernacular are normally capitalized. How complete sentences in the vernacular 
are capitalized and punctuated is decided by the author but should be consistent throughout a work. 
If capitalization is not used, sentences in the text may need to be reworded so that lowercase 
vernacular words do not occur as the first word in the sentence. 

• International Phonetic Alphabet (IPA) script, e.g., fəˈnɛtɪk, and foreign scripts, e.g., Chinese, are 
not italicized. 
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• For biblical language texts, SIL Unicode fonts other than Charis SIL may be preferred. These are 
Galatia SIL (Greek), Doulos SIL (IPA), and Ezra SIL (Hebrew). For Asia there are other alternatives. 

9.2 Glosses and free translation in interlinear text 

• A gloss is a translation of vernacular word(s) in a text. Glosses are in lowercase, regular type, 
within single quotes, e.g., in Cubeo (Colombia): xu ‘nest’. 

• A word comprises one or more morphemes (grammatical units). Morphemes within a word are 
separated by hyphens, e.g., xu-A. 

• Grammatical category abbreviations2 in the gloss are given in small caps uppercase, e.g., CAUS 
(causative). In the body text, these appear in parentheses, e.g., xu-A (nest-CAUS). 

• Free translations are enclosed in single quotes, e.g., xu-A ‘set a trap’. 
• Interlinear text aligns vernacular words with its gloss and free translation in rows; and the 

vernacular with its gloss, by columns, separated by tabs. See also A.5. 
Vernacular xu-A 
Gloss nest-CAUS 
Free translation ‘set a trap’ 

• Person reference is glossed as 1, 2, 3, as in 1S (1st person, singular), e.g., in southern Peruvian 
Quechua: puri-sha-ni (go-CONT-1S) ‘I am going’. 

• Periods join two or more words which gloss a single vernacular morpheme, e.g., in Spanish: mostrar 
‘to.show’. This is not true for the free translation. 

• Clitics are syntactic morphemes, phonologically bound. When bound they are separated by an equal 
sign (=), e.g., what=s (as in what’s) ‘what.is’. 

• Avoid footnotes in interlinear examples when possible. 

10 Tables, maps, and figures 

• Titles, or headings, for tables and maps appear above the information they label, as in table 1. 
• A period follows the number but not the text of the heading. If the object is centered, the heading is 

also centered. Headings for left-aligned tables are also aligned to the left. See also Appendix A.6.2. 

Table 1. Relative contents of odd isotopes for heavy elements 

Sample table Sample table Sample table Sample table 
 

• In many cases borders are not needed around tables. Lines may be used, when necessary, to make 
the table easier to read. Lines should separate the table heading and column headings from the 
columns, and the end of the table from the rest of the text. 

• Table notes occur immediately following (adjacent to) the table. They are marked with lowercase 
superscript letters (a, b, c, etc.). For examples, see Appendix A.6.2. 

• Tables are normally numbered separately from maps, and maps from figures.3 
• The table or figure, with its title, should fit on a single page whenever possible. 
• Captions for figures appear below the object. A period follows the number and the heading. See the 

caption following figure 1, and Appendix A.8, for examples. 

                                                   
2 GPS recommends the use of the Leipzig Glossing Rules, which gives the increasingly international standard for 
linguistic abbreviations. See http://www.eva.mpg.de/lingua/resources/glossing-rules.php. 
3 In some linguistic theories figures and tables are treated as examples and given that example number. 

http://www.eva.mpg.de/lingua/resources/glossing-rules.php
http://www.eva.mpg.de/lingua/resources/glossing-rules.php
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Figure 1. Sample figure caption for a graphic object. 

11 Appendices 

Appendices include substantiating data that would interrupt the flow of the manuscript. These often 
include long wordlists, charts, and interview forms. A page break occurs before and following an 
appendix. The appendices are treated differently than headings and chapter breaks, and so are not 
numbered. If there is more than one appendix, capital letters distinguish them from each other. For 
example, “Appendix A: Perturbation of Target Nouns in Tone Frames.” 

12 References 

ILS uses the term references rather than bibliography. References occur following any optional appendices. 
In collections, the references list occurs at the end of each chapter instead of at the end of the volume. In 
this section the elements of an entry are described individually and in the order of appearance in the 
entry (author, date, title, etc.). 

Current practice is to keep font and punctuation characteristics as simple as possible. All elements of 
a reference entry, except the title of a book or journal, are given in non-italic, plain type, and without 
quotation marks. Quotation marks are used only to highlight isolated words or phrases; they do not set 
off titles of works. Each element in a reference entry ends in a period. 
• Reference entries are limited to those actually cited in the text of the manuscript. Additional 

references are only rarely included in a work, and only if listed separately as Additional Reading. 
• Some physical facts about a work that are appropriate for library catalog cards or booksellers’ 

lists—dimensions, type of cover, number of pages in the book, number of illustrations—are not 
given in a list of references for GPS. 

12.1 Name of authors, editors, translators, and compilers 

12.1.1 Authors 

The first element of a reference is the author’s name, surname first and set off by a comma, with the 
given names following in order. 
• The author’s given names, as listed in the work, are spelled out—and without citing degrees or 

titles, e.g., the title, PhD, in Charles F. Hockett, PhD, is omitted. 
Hockett, Charles F. 

• An author’s full name is given, if listed as such. Only if an author prefers to be known by initials 
only, are they used in lieu of the full name, e.g., Eliot, T. S. 

• In the case of more than one author, only the name of the first author is given in inverse order. If 
two authors have the same surname, give each name in full. A comma separates the name of each 
author from that of the following one. 

Pike, Kenneth L., and Evelyn G. Pike. 
Wonderly, William L., Lorna F. Gibson, and Paul L. Kirk. 

• Do not use et al. when listing multiple authors in references. The abbreviation may be used in the 
text citation, but the names of all authors are given in reference entries. 
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• When two or more publications by the same author or combination of joint authors are referenced 
in the same list, the list is given first alphabetically, then in normal chronological order. 

Rensch, Calvin R. 1968. Proto Chinantec phonology. Papeles de la Chinantla 6. Serie Científica 10. 
México: Museo Nacional de Antropología. 

Rensch, Calvin R. 1989. An etymological dictionary of the Chinantec languages. Studies in 
Chinantec Languages 1. Summer Institute of Linguistics and the University of Texas at 
Arlington Publications in Linguistics 87. Dallas. 

Rensch, Calvin R., and Carolyn M. Rensch. 1966. The Lalana Chinantec syllable. In Antonio 
Pompa y Pompa (ed.), Summa antropológica en homenaje a Roberto J. Weitlaner, 455–463. 
México: Instituto Nacional de Antropología e Historia. 

• If a publication issued by an entity bears no personal author’s name on the title page, it is listed by 
that entity, even if the entity name is repeated later in the same reference entry. 

Graduate Humanities Program. 1988. Graduate Humanities Program Student Handbook. 
Arlington: The University of Texas at Arlington. 

12.1.2 Editors, translators, and compilers 

• The person or people listed on the title page as editors, translators, or compilers are noted in the 
author category with that function in abbreviated form following their name(s)—eds., trans., comps. 
These are not given within parentheses. The abbreviation is followed by the date. 

Loving, Richard, and Gary F. Simons, eds. 1977. 
Saxton, Dean, and Lucille Saxton, trans. 2015. 
Travis, Donald, and Janet Coombs, comps. 2016. 

• Note in section 12.3.3, that editors, translators, or compilers of a larger work within which an 
article or book is found, e.g., a collection, the abbreviation is given within parentheses. 

12.2 Date of publication 

The second item in a reference entry is the year of publication. It is set apart by periods before and after. 
• If two or more publications by the same author or combination of authors are listed as having been 

published in the same year, lowercase letters beginning with “a” and “b” are appended to the date, 
in alphabetical order, to distinguish them for purposes of citation in the text. 

McArthur, Harry S. 1966a. El faccionalismo político-religioso… 
McArthur, Harry S. 1966b. Orígenes y motivos… 

• A manuscript that has not yet been published can be referred to in several ways in lieu of an actual 
publication date. If the manuscript is scheduled to appear in a particular outlet (an editor has 
accepted it), the words forthcoming, to appear, or in press can substitute for an actual date. 

Barreteau, Daniel. Forthcoming. La transitivité en mofu-gudur. Paris: Société d’Études 
Linguistiques et Anthropologiques de France. 

• Dates for publications can be given either in European style, with the days preceding the month, or 
American style, with the name of the month occuring first. The convention should be consistently 
applied within a work. 

• A manuscript for which a specific outlet has not yet been secured can be cited by the date of 
writing, with the abbreviation for the word “manuscript” (ms.) placed at the end of the citation in 
lieu of a place of publication and publisher. See also 12.5. 

Beavon, Keith H. 1978. A comparative analysis and historical reconstruction of Konzime noun 
class prefixes and consonantal phonemes. Ms. 

• A published work that shows no publication date is shown as having no date (n.d.): 
Smith, John T. n.d. The problem of… 
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12.3 Titles 

12.3.1 Book titles 

Reference lists for book titles are of various types: Simple monographs, those with multiple editions or 
volumes, books that are members of a series or collection, and books reviewed in a journal, to name a 
few. This section shows simple titles, and with subtitles; how editions and volume numbers are shown; 
and an example of how a foreign title is translated into English. 
• Book titles are sentence capitalized and italicized. 

Hollyman, Jim, and Andrew Pawley, eds. 1981. Studies in Pacific languages and cultures in honour 
of Bruce Biggs. Auckland: Linguistic Society of New Zealand. 

• Subtitles are separated from titles by a colon. The first word of the subtitle is capitalized. 
Wendland, Ernst R. 2013. Orality and the Scriptures: Composition, translation, and transmission. 

Publications in Translation and Textlinguistics 5. Dallas: SIL International. 
• An edition number follows the book title, separated by periods, and is written out, not 

abbreviated, and given in non-italic type. 
Merrifield, William R., Constance M. Naish, Calvin R. Rensch, and Gillian Story. 1987. 

Laboratory manual for morphology and syntax. Sixth edition. Dallas: Summer Institute of 
Linguistics. 

• A volume number follows the book title and a period. The word volume is normally capitalized and 
abbreviated (Vol.) followed by the number as a numeral, all in non-italic type.  

Harley, J. B., and David Woodward, eds. Cartography in the traditional East and Southeast Asian 
societies. Vol. 2. Chicago: University of Chicago Press. 

• Some books have multiple volumes under the same title. When the volumes are cited as a whole, 
the number of volumes in the set and the abbreviation for volumes (vols.) is given in lowercase, 
non-italic type following the title and a comma. 

Webster, Jonathan J., ed. 2005. Collected works of M. A. K. Halliday, 10 vols. London: Continuum 
International Publishing Group. 

• When multivolume works have both a general editor and individual editors or authors for each 
volume, an individual author and volume is cited and the editor’s (or translator’s) name follows that 
work for which he is responsible. 

Barrows, Herbert. Reading the short story, Vol. 1 of An introduction to literature, ed. Gordon N. 
Ray. Boston: Houghton Mifflin, 1959.  

• A translation of the title may be given in regular type, within brackets, following a foreign 
language title. 

Buck, Marjorie. 1963. Welo ñequio wela [Grandpa and grandma]. Mexico: Instituto Lingüístico de 
Verano. 

12.3.2 Series titles 

When a book is part of a series, the series title and number follow the book title. Series titles are 
headline capitalized and in regular type. The word number (No.) is not used. 

Hunt, Geoffrey R., and Rosemary H. Hunt. 1981. A phonology of the Hanga language. Collected 
Field Notes Series 18. The Institute of African Studies, University of Ghana, Legon. 

• The term workpapers is sometimes part of a formal series title, as seen in this example. 
Loving, Richard, and Gary F. Simons, eds. 1977. Language variation and survey techniques. 

Workpapers in Papua New Guinea Languages 21. Ukarumpa, Papua New Guinea: Summer 
Institute of Linguistics.  
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• A book can be a part of a series within a series. See here, and the example for the next bullet point. 
Rensch, Calvin R. 1968. Proto Chinantec phonology. Papeles de la Chinantla 6. Serie Científica 10. 

México: Museo Nacional de Antropología. 
• Institutional names are sometimes part of a series title, especially in the case of educational 

institutions. In the following example, 56 is the series issue number. Since the publisher’s name is 
part of the series title, it is not repeated following the place of publication (see also 12.4). 

Langacker, Ronald W., ed. 1977. An overview of Uto-Aztecan grammar. Studies in Uto-Aztecan 
Grammar 1. Summer Institute of Linguistics and the University of Texas at Arlington 
Publications in Linguistics 56. Dallas. 

12.3.3 Titles of articles and published papers 

Article titles are sentence capitalized and in regular type. Only in the text stream is the title headline 
capitalized and appears in quotation marks. For a subtitle, a colon separates the title from subtitle. 
Articles and published papers appear in journals, collections, and proceedings. 

Articles in a journal 

The journal name follows the article title and is headline capitalized and italicized. 
Abaglo, P. and Diana Archangeli. 1989. Language particular underspecification: Gengbe /e/ and 

Yoruba /i/. Linguistic Inquiry 20:457–480. 
• Journal editors are ordinarily not named. The volume and page numbers follow the journal name. 

They are separated by a colon without an intervening space. 
Foris, David. 1973. Sochiapan Chinantec syllable structure. International Journal of American 

Linguistics 39:232–235. 
• Most journals publish one volume per year with two or more issues. The issue number is not cited 

unless the journal follows the practice of numbering its pages from “1” in each issue, in which case 
the number of the issue appears in parentheses between the volume number and the colon. 

Merrifield, William R. 1963. Palantla Chinantec syllable types. Anthropological Linguistics 5(5):16. 
• In the rare case that volume, number, and issue details must all three be given for a journal article, 

follow this pattern: 
Dhungel, B. A., K. U. Dhungel, J. M. Easow, and Y. I. Singh. 2008. Opportunistic infection among 

HIV seropositive cases in Manipal Teaching Hospital, Pokhara, Nepal. Kathmandu Medical 
Journal, Vol. 6, 3(23):335–339. 

Articles in collections and proceedings 

An article may be included in a collection of articles assembled by one or more editors; papers read in a 
professional workshop or conference may, likewise, be published as the proceedings of that event. 

In a collection the article title is sentence capitalized and in regular type. It is followed by In, the 
editor’s names (first, then last); the editor’s title (ed.), and the collection title, which is sentence 
capitalized and in italic type. The title is followed by a comma, the page range for the article, a period, 
then place of publication and publisher. The word page(s) is not used in full or abbreviated form with the 
page numbers. 

DeLancey, Scott. 2003. Classical Tibetan. In Randy LaPolla and Graham Thurgood (eds.), The 
Sino-Tibetan languages, 255–269. New York: Routledge. 

Hollyman, Jim, and Andrew Pawley. 1981. Bruce Biggs: A foreword. In Jim Hollyman and 
Andrew Pawley (eds.), Studies in Pacific languages and cultures in honour of Bruce Biggs, 7–23. 
Auckland: Linguistic Society of New Zealand. 
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• If an author lists three or more articles from the same collection, the collection may be listed as a 
separate entry. 

Clements, G. N., and Elizabeth Hume. 1995. The internal organization of speech sounds. In John 
Goldsmith (ed.), The handbook of phonological theory, 28–33. Cambridge, MA: Basil Blackwell. 

Goldsmith, John, ed. 1995. The handbook of phonological theory. Cambridge, MA: Basil Blackwell. 
• If the larger work is listed in the references separately, the individual article entries can be 

shortened to include only the names of volume editors and page numbers, without other details. 
Clements, G. N., and Elizabeth Hume. 1995. The internal organization of speech sounds. In 

Goldsmith, 283–333. 
• The book in which an article appears may also be a member of a series, as in the case of 

Workpapers in Papua New Guinea Languages 21, following: 
Collier, K. J. 1977. Predicting intelligibility: A suggested technique. In Richard Loving and Gary 

F. Simons (eds.), Language variation and survey techniques, 253–261. Workpapers in Papua 
New Guinea Languages 21. Ukarumpa, Papua New Guinea: Summer Institute of Linguistics. 

Papers published in the proceedings of an official event are like articles in a collection. However, 
the name, place, and date of the conference are given, followed by the page sequence, and place and 
name of the publisher (which may or may not be the same as the meeting organizers and location). 

Grimes, Joseph E. 1964. Measures of linguistic divergence. In Horace G. Lunt (ed.), Proceedings 
of the Ninth International Congress of Linguists, Cambridge, MA, August 27–31, 1962, 44–50. 
The Hague: Mouton. 

In the following example the proceedings are given within a series title: 
Crook, Rena, Leanne Hinton, and Nancy Stenson. 1977. Literacy and linguistics: The Havasupai 

writing system. In James E. Redden (ed.), Proceedings of the 1976 Hokan-Yuman Languages 
Workshop, University of California, San Diego, June 21–23, 1976, 1–16. University Museum 
Studies 11. Carbondale, IL: Southern Illinois University. 

12.3.4 Book reviews 

Books that are reviewed by others are listed with the reviewer’s name followed by Review of (without 
punctuation), the book title, and author(s) or editor(s). Then follow applicable guidelines for citing 
periodicals. For reviews other than of books, see CMOS, 14.214–14.217. 

Sorby, Angela. Review of Songs of ourselves: The uses of poetry in America, by Joan Shelley Rubin. 
American Historical Review 113 (April 2008):449–450. 

Levinsohn, Stephen H. Review of Discourse features in Balochi of Sistan (Oral narratives), revised 
edition (2011), by Behrooz Delforooz Barjasteh. Orientalia Suecana LX:193–197. 

12.4 Place of publication and publisher 

The last sequence of a reference entry is the city where the work was published and the name of the 
publisher. 
• Place of publication is not ordinarily indicated for an article in a journal. However, in the case of a 

periodical publication of an institution (usually an educational institution—as opposed to a 
professional society), place of publication and publisher serves to clearly identify the publication. 

Beavon, Keith H. 1984. Tone and intonation in Konzime. Cahiers du Département des Langues 
Africaines et Linguistique 3:23–37. Yaoundé, Cameroun: University of Yaoundé. 

• The city of publication is given, without reference to country or state unless the city may be 
confused with another, or the location of the city is not widely known. When the state is given, it is 
with a two letter abbreviation, i.e., letter postal code, e.g., IL for Illinois. See CMOS, section 10.27. 
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• The printing house is not to be confused with the publisher. The publisher’s name is shown as 
having the copyright. 

• The name of publisher is the last element of an entry. If the publisher’s name appears verbatim 
elsewhere in the entry as, for example, in the series name, there is no need to repeat it. 

Rensch, Calvin R. 1989. An etymological dictionary of the Chinantec languages: Studies in Chinantec 
Languages 1, Summer Institute of Linguistics and the University of Texas at Arlington 
Publications in Linguistics 87. Dallas. 

• The entry ends with the publisher’s name followed by a period. 
Comrie, Bernard. 1976. Aspect: An introduction to the study of verbal aspect and related problems. 

Cambridge: Cambridge University Press. 

12.5 Unpublished papers, dissertations/theses, manuscripts 

• A paper read but not published gives the author, year, the name of the professional meeting where 
it was read, the place of the meeting, and the dates of the meeting. The dates may be given either 
European or American style (see 12.2), as long as that convention is used consistently. 

Jaouen, René. 1974. Le verbe en giziga. Paper presented at the XIe Congres de la Société de 
Linguistique de l’Afrique Occidentale, Yaoundé, Cameroun, August 1–4, 1974. 

Hyman, Larry. 1999. The limits of phonetic determinism in phonology: NC revisited. Paper 
presented at the Linguistic Society of America, Los Angeles, January 1999. 

• A dissertation or thesis gives the author, year, the manuscript title, the degree earned, the name of 
the institution and location. When the city is part of the university name it is not given separately. 

Keuleers, Emmanuel. 2008. Memory-based learning of inflectional morphology. PhD dissertation. 
University of Antwerp. 

Myers, Scott. 1987. Tone and the structure of words in Shona. PhD dissertation. University of 
Massachusetts, Amherst. 

Steinkraus, Walter. 1964. Procedures for translating figures of speech in the Gospel of John. MA 
thesis. Wheaton College, IL. 

• Unpublished manuscripts are listed with the author, date of writing, the title, and the initials “Ms.” 
for manuscript. 

Nakiengar, R. 1984. La phonologie sar. Ms. 
Beavon, Keith H. 1978. A comparative analysis and historical reconstruction of Konzime noun 

class prefixes and consonantal phonemes. Ms. 

12.6 References from a website 

• If the author consulted an article online, include a URL. If no author is identified, begin the citation 
with the article title. Give the title, publisher, and date; then give the date the author accessed the 
site; follow that with the website link. No hyperlink style is applied to URLs when given in the 
reference section of print books. 

• It is good practice for an editor to access the URL to verify that it is still active. However, the date 
that the author accessed the URL is what is of interest for the sake of documentation. 

Stolberg, Sheryl Gay, and Robert Pear. Wary centrists posing challenge in health care vote. New 
York Times, February 27, 2010. Accessed February 28, 2010. 
http://www.nytimes.com/2010/02/28/us/politics/28health.html. 

Arduini, Stephano. Presentation of the general theme. Murcia, Italy, June 3–5, 2010. Accessed 
March 26, 2013. http://www.nidainstitute.org/Conferences/TranslationandCognition.dsp. 

  

http://www.nytimes.com/2010/02/28/us/politics/28health.html
http://www.nytimes.com/2010/02/28/us/politics/28health.html
http://www.nidainstitute.org/Conferences/TranslationandCognition.dsp
http://www.nidainstitute.org/Conferences/TranslationandCognition.dsp
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• A Digital Object Identifier (DOI) is a unique and permanent name assigned to intellectual property 
such as an article or book. A DOI points to the source, much as do URLs. CMOS recommends use of 
DOIs as “more reliable resource identifiers,” and suggests that “authors…include DOIs rather than 
URLs for sources that make them readily available” (2010:657). As seen in the first example below, 
the DOI is not hyperlinked (underlined) unless part of the URL, as in example two. 

Menjívar, Cecilia. 2006. Limited Legality: Salvadoran and Guatemalan immigrants’ lives in the 
United States. American Journal of Sociology 111(4):999–1037. Doi:10.1086/499509. 

• A DOI may be embedded within a URL name (here, at the end of the URL). 
Malone, Susan E., and Patricia Paraide. 2012. Multilingual education in Papua New Guinea. 

International Review of Education 57(5):705–720. http://www.springerlink.com/ 
openurl.asp?genre=article&id=doi:10.1007/s11159-011-9256-2. 

http://www.springerlink.com/%20openurl.asp?genre=article&id=doi:10.1007/s11159-011-9256-2
http://www.springerlink.com/%20openurl.asp?genre=article&id=doi:10.1007/s11159-011-9256-2
http://www.springerlink.com/%20openurl.asp?genre=article&id=doi:10.1007/s11159-011-9256-2
http://www.springerlink.com/%20openurl.asp?genre=article&id=doi:10.1007/s11159-011-9256-2


 
 

 

 

Appendix A: SIL Template Guidelines 

Title Page Title (SIL Front Title) 

Subtitle (SIL Front Subtitle) 

Author (SIL Front Author) 

SIL International® (SIL Front Publisher-Year) 
2019 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SIL (name of journal or series) YYYY-issue number, Month YYYY (SIL Front Copyright) 
© YYYY Author names (first and last), and SIL International® 
All rights reserved 

Comments: 
• ®, above, uses SIL Footnote Number style. Use Shift+Enter between publisher and year lines. 
• GPS compositors will insert the final pagination, table of contents, and verso pages for books. 
• Insert (from the Ribbon) Layout/Breaks/Section Break/Next Page after copyright section, below. 
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This page is intentionally blank.



 
 

19 
 

SIL e-Books 
75 
 

 2019 SIL International® 
ISBN: XXX-X-XXXX-XXX-X 

ISSN: XXXX-XXXX 

 

Fair-Use Policy  
Books published in the SIL e-Books (SILEB) series are intended for scholarly research 
and educational use. You may make copies of these publications for research or 
instructional purposes free of charge (within fair-use guidelines) and without further 
permission. Republication or commercial use of SILEB or the documents contained 
therein is expressly prohibited without the written consent of the copyright holder(s). 

 
Orphan Works Note  
Data and materials collected by researchers in an era before documentation of 
permission was standardized may be included in this publication. SIL makes diligent 
efforts to identify and acknowledge sources and to obtain appropriate permissions 
wherever possible, acting in good faith and on the best information available at the 
time of publication. 

 

Series Editor 

Editor’s Name 

 

Volume Editor 

Editor’s Name 

 

Managing Editor 

Editor’s Name 

 

Compositor 

Compositor’s Name
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A.1  Print book headings and chapter titles 

In print books, part headings (e.g., abstract, contents, appendices, references) and chapter titles (see 
below) are styled with SIL Hdg Ch Ctrd. They are headline capitalized and start a new recto (odd-
numbered) page. Chapter titles have the chapter number manually entered immediately above the title 
using a no-break line space (Shift+Enter). 

5 
Sample Title of Chapter Five for a Print Book 

First level headings (SIL Hdg1 Ctrd) are centered, manually numbered, and sentence capitalized (see 
below). The two digit number includes chapter and heading numbers, separated by a period and 
followed by a tab, as illustrated: 

5.1 Sample first level heading of chapter five for a print book 

Second level and subsequent headings are aligned flush left and are sentence capitalized. The two digit 
number includes chapter and heading numbers. Except for the added chapter number, these are identical 
to the headings in A.2. 

5.1.1 Sample second level heading of chapter five for a print book 

A collection is a print book in which each chapter is written by a different author. In this case the 
author’s name appears beneath the chapter title using SIL Hdg Ch Author style. An abstract for the 
chapter follows the author’s name. The abstract text is styled with SIL Para 1. 

A.2  E-Book and paper headings and chapter titles 

For e-Books and papers, all part headings (see A1, above) and chapter titles (SIL Hdg Ch Left) are 
headline capitalized; they and level headings are normally flush left. All numbering is manual. A tab is 
used to space after the number. No punctuation follows either the number or the heading text. E-Books, 
like print books, may give both the chapter and heading number (see A.1, above). See examples here and 
at 4.1.1. 

1 First level heading (SIL Heading 1) 

1.1 Second level heading (SIL Heading 2) 

1.1.1 Third level heading (SIL Heading 3) 

A.3  Text: Paragraph styles (and the line spacer) 

SIL Para 1 style is used for the first paragraph to follow a heading. It is not indented. 
SIL Para 2 style is for second and succeeding text paragraphs. The first line is indented 0.3″. See 

example, below: 

SIL Para Long Quote style is for quotations longer than four lines; it is in 9 pt type and is set off 
from both margins. The first line is not indented from the left margin of the paragraph. 

However, second and succeeding paragraphs within the long quotation use SIL Para Long 
Quote 2, which indents the first line, as in this paragraph. For more, see section 4.2. 
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The SIL Line Spacer style adds 5 pt spacing between paragraphs. A sample separates this line… 
 

from this line. 

A.4  Character styles 

• SIL Chr Data (used for IPA and non-italic vernacular data) 
• SIL Chr Italic (used for emphasis, book and journal titles, etc.) 
• SIL Chr Bold (use sparingly, for emphasis and table headings) 
• SIL CHR TECHNICAL (used for special vocabulary; on lowercase text, select, then tag this style) 
• SIL Chr Underline (use sparingly, for emphasis) 
• SIL Chr Vernacular (used for vernacular data in the text) 
• SIL Chr Vernac Emphatic (used to emphasize [italicized] vernacular data) 
• SIL Chr Vernac Underline (used to emphasize [italicized] vernacular data) 
• SIL Footnote Ref (superscripts footnotes and table notes; used to superscript after apply template) 

A.5  Bullet lists, example lists, and interlinear text 

SIL Bullet and SIL List Example styles have the grammar and spelling check feature turned off. 
• This is SIL List Bullet 1 style. 

• This is SIL List Bullet 2 style. 
• This is SIL List Bullet 3 style. 

Auto numbering keeps your item and example lists ordered. When ready to submit, save one copy, 
then select the entire text of another copy and freeze the numbering with Ctrl+Shift+F9. This is 
irreversible. Send both to GPS. 
1. SIL List Item 1 is for numbered or itemized lists, followed by a period and tab, as shown here: 

a. This is SIL List Item 2 style. 
i. This is SIL List Item 3 style. 

(2) The SIL List Examples style is used for language examples. These are typically numbered within 
parentheses. A hanging indent keeps the example text aligned, as shown here. 

(3) Vernacular wordlists can be generated by inserting a manual line break (Shift+Enter), instead of a 
carriage return at the end of the paragraph text and after each word. This is used to style 3a, b. 
a. ŋɪɪŋ 
b. daak͡pɪɪŋ 

(4) Style Interlinear text with SIL Table L Text. See A.6.1 to prepare the text and insert into a table. 
• To align an example number with a table, e.g., (5), set up the table; select left column, right click 

selection; Insert a column to the left, click in the top, left cell, and tag SIL List Examples. Select 
that column; right click; select Table Properties, Column tab, and set Preferred width to .31″. 

• To remove the table border, select the table; at the Design tab, use the Border menu and set No 
Border. (Here the border is marked for illustration only.) Note that the free translation below the 
table can be styled as within a cell of the table (A.6.2) or separately, as below, with SIL Para 2. 

 

(5)  phonetic m̀ mɪ ́ !ń tígírú  wó !bɪńnɪḿá   

 morpheme N mɪ N tig -ri wo bɪn -rI -mA 
 gloss 1S build 1S house DEF TRANS year DEF LOC 

 ‘I built my house last year.’ 
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A.6  Tables 

A.6.1 Table left headings and table left text 

The title for tables, charts, and maps, is called a table heading, and appears above the object. 
Optional column titles within a table or chart are called table headers. These can be styled with SIL Chr 
Bold for emphasis. See examples, tables 1 and 3. 

To set up a table, align the text in columns, using tabs. Next, with the entire text selected, at the 
Insert tab, select Table, then Convert Text to Table, and AutoFit to contents; click OK. To left-align the 
text in each cell, with the entire text highlighted, style with SIL Table L Text. 

Table cells can be adjusted for height and width. Hover the cursor over table borders, then select 
the border and drag; alternatively, select the entire table and click on the Layout tab at the right of the 
ribbon. Then adjust the Cell Size at the center of the ribbon. 

Table 1. This is SIL Table L Heading 1 style 

Table header Table header Table header Table header Table header 
Table Text Table Text Table Text Table Text Table Text 

 

For the SIL Table L Heading 2 style, with the table already set up (see instructions, above), set the 
heading; then select the entire table text; open the (rightmost) Layout tab, click Table Properties, Table 
tab, and Indent from left: 0.31″. 

Table 2. This is SIL Table L Heading 2 style 

1. jɔŕɔŋ́ ladder jɔŕɔŋ́ wʊ́n!ná jɔŕɔŋ́ !káánɪ ́
 H-H  ŋ̀ wó jɔŕɔŋ́ ʊ̀ jɔŕɔŋ́ 
2. hɔg̀ʊ́ woman hɔg̀ʊ́ wʊ́n!ná hɔg̀ʊ́ !káánɪ ́
 Ø  ŋ̀ wó !hɔǵʊ́ ʊ̀ hɔǵʊ̀ 

A.6.2 Table center heading and table center text; notes in a table 

The SIL Table Ctr Text style centers text in table cells. Alternatively, with the full text or table selected, 
Ctrl+E centers both the heading and table on the page, and the text within the cells. 

For table notes, create an empty cell below the table text and insert the notes into the cell, as 
follows: Click in the last table cell; select the Layout tab, Insert Below; then Merge Cells. To remove cell 
border, at the Design tab, Border menu, set No Border; then set Top Border. Use letters or symbols for 
the table note referent; style with SIL Footnote Ref. Style the 9 pt table note text with SIL Footnote 
Text. 

Table 3. This SIL Table Ctr Heading style is also for maps 

Table headera Table header Table headerb Table header Table header 
Table text Table text Table text Table text Table text 

aThe table note referents use the SIL Footnote Ref style. 
bThe table note text uses the SIL Footnote Text style. 

.6.3 Small and tiny text options for tables 

Two paragraph style options allow for a smaller text size for tables, permitting more cells in a table. 

Table 4. This is SIL Table Text 9.5 pt 
  

Table 5. This is SIL Table Text 9 pt   

Small text Small text Small text Small text   Tiny text Tiny text Tiny text Tiny text 
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A.7  Footnotes 

• To insert a footnote use the ribbon as follows: Click on the References tab, then on Insert Footnote. 
For table notes, see Appendix A.6.2. 

• Footnote text and footnote numbers may become altered in the process of attaching a template. If 
so, tag the SIL Footnote Ref and SIL Footnote Text styles in the Styles Panel to convert the note 
numbers and text to the correct form. 

A.8  Figures and graphics 

The SIL Figure Graphic style centers the figure or graphic image. The title for figures and graphic images 
is called a caption. SIL Figure Caption centers the figure caption below the object. 

 
Figure 1. The SIL Figure Caption style centers the caption text. 

A.9  Appendices and references 

Appendices are not part of the central text, and so are assigned a capital letter (Appendix A, B, etc.) and 
heading numbers follow that letter (A.1, A.2, etc.). Appendix headings are styled with SIL Hdg Ch Ctrd 
(print books) or SIL Hdg Ch Left (e-Books and papers). A page break precedes each appendix. 

References is a part heading that is also not part of the central text—and so the heading is not 
numbered. A page break precedes the part heading. The heading is styled with SIL Hdg Ch Ctrd (print 
books) or SIL Hdg Ch Left (papers). Reference entries are styled with SIL Reference Entry. Entries are 
flush left, with a hanging indent of 0.3″. See the example here and others in section 12. 
 

Hyman, Larry. 1999. The limits of phonetic determinism in phonology: NC revisited. Paper given at the 
Linguistic Society of America, Los Angeles, January 1999.
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Appendix B: Layout Specifications 

B.1  Basic setup 

Application MS Word (preferably 2007, 2010 or later) 
Document division 

Papers 
Books 

 
 

Treat as one document 
If long, complicated, or has landscape pages, separate into chapters 

Page layout Single page (File>Page Setup>Paper) 
Paper size, layout 8.5″ x 11″ (File>Page Setup>Paper; or Page Layout>Size) 
Margins 1″ all around (File>Page Setup>Margins; or Page 

Layout>Margins) 
Justification Unjustified for electronic viewing 
Page numbers (Insert>Page numbers>Header & Footer); see also B.2 
Font: SIL Normal 10 pt Charis SIL; 12 pt leading (for all but non-roman script) 
Numbering Only SIL List Examples and SIL List Item 1 are auto numbered 
Security/developer; protect 
Fonts 
Navigation tab 

None/Unrestricted 
All embedded or embedded subsets 
Bookmarks panel and page 

Level-head spaces Space before and after; same as leading for heading 

B.2  Page numbering and titles in headers and footers 

Headers 
Footers 

9 pt; regular; right; 11 pt leading 
9 pt; regular; left; 11 pt leading 

 

Front matter 
Roman numerals: title and verso pages count but don’t appear; first 
page number of each new part (contents, preface, acknowledgments, 
abbreviations, etc.) appears bottom center; top right margin for all 
others (electronic); alternating top margins for print books. 

Central text page numbering 
Papers 

Number pages with arabic numerals; begin counting with main text. 
Numbering first appears on page 2 or 3 of main text, bottom center; 
all others top, right. 

e-Books, Print Arabic numbering starts on first page of main text and continues 
sequentially to end. Numbers appear at bottom center of first page 
of parts (e.g., chapter 1, references, Appendix A); numbering on all 
other pages occurs at top, on alternating margins. 
Page, chapter, and author vary for different print books (see here): 

Monographs left page—page number flush left, chapter title flush right 
right page—highest level sect head flush left, page number flush 
right 

Collections left page—page number flush left, author name flush right 
right page—article title flush left, page number flush right 

Dictionaries left page—first entry on page flush left, page number flush right 
right page—page number flush left, last entry on page flush right 
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B.3  Front matter and end matter 

Specifications vary for papers, e-Books, and print books. See also Appendices A.1 and B.1–B.2. 

B.3.1 Title page (papers, e-Books) 

The text should be nicely centered on the page. The following are guidelines: 
 

SIL Front Title 
Papers 
E-Books 

 
18 pt; bold; centered; 20 pt leading; 114 pt before; 14 pt after 
18 pt; bold; centered; 20 pt leading; 60 pt before; 40 pt after 

SIL Front Subtitle 16 pt; bold; centered; 18 pt leading; 0 pt before; 14 pt after 
SIL Front Author 

Papers 
E-Books 

 
12 pt; regular; centered; 14 pt leading; 0 pt before; 144 pt after 
10 pt; regular; centered; 12 pt leading; 0 pt before; 324 pt after 

SIL Front Publisher-Year 
Papers 
E-Books 

(SIL International®) 
12 pt; bold; centered; 14 pt leading; 0 pt before; 222 after 
12 pt; bold; centered 

SIL Front Copyright 
Papers 
E-Books 

 
10 pt; regular; left; 11 pt leading 
11 pt; regular; left; 12 pt leading 

B.3.2 Verso page 

SIL E-Books 10 pt; regular; centered 
xx (series number) 10 pt; regular; centered 
©2019 SIL International® 10 pt; regular; centered 
ISBN: xxx-x-xxxxx-xxx-x 10 pt; regular; centered 
ISSN: xxxx-xxxx 10 pt; regular; centered 
Fair use policy 9 pt; regular; block: left indent 36 pts; right indent 36 pts 
Production Title (editor) 10 pt; bold; centered 
Production name (compositor) 10 pt; regular; centered 

B.3.3 Contents 

No leader or page numbers on contents page. All entries are made into live links. 
Contents See B.4; different for e-Books and papers vs. print books 

SIL TOC Bk 1 Number/tab; 10 pt; regular; left; headline capitalized 

SIL TOC Bk 2 Number/tab; 10 pt; regular; indent to first letter of level 1 

SIL TOC Bk 3 Number/tab; 10 pt; regular; indent to first letter of level 2 

Appendices Regular; left; 10 pt; headline capitalized 
References Regular; left; 10 pt; headline capitalized; hanging indent .3″; 6 pt after 
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B.4  Headings 

SIL Hdg Ch Left (e-bks, papers) 
SIL Hdg Ch Ctrd (books) 

Contents title 
Abstract title 
Abbreviations title 
Appendices titles 
Reference title 
Chapter titles 

After p. break; 14 pt; bold; left; 16 pt leading; 16 pt before, 16 after 
After p. break; 14 pt; bold; centered; 16 pt leading; 16 pt before, after 
Same style as above; centered for print books; left for e-Books, papers 
Same as previous (and for each of the following part titles, also:) 

SIL Hdg Ch Authors 10 pt; centered; 12 pt leading; 12 pt before; 0 pt after 
SIL Heading 1 

Papers (1+tab) 
12 pt; bold; left; 14 pt leading; 16 pt before; 16 pt after 
No chapter number with heading number; manually number all hdgs 

SIL Hdg1 Ctrd 
Books (1.1+tab) 

12 pt; bold; centered; 14 pt leading; 14 pt before; 14 pt after; 
Ch. number with heading number; manually number all headings 

SIL Heading 2 
Papers (1.1+tab) 
Books (1.1.1+tab) 

12 pt; bold; left; 14 pt leading; 14 pt before; 14 pt after 
No chapter number 
Chapter number with heading number (likewise for subsequent hdgs) 

SIL Heading 3 (1.1.1+tab) 12 pt; bold, italic; left; 14 pt leading; 14 pt before; 14 pt after 
SIL Heading 4 12 pt; Italic; left; .75″ hanging; 14 pt leading; 14 pt before; 14 pt after 
SIL Heading 5 10 pt; Italic; left; .9″ hanging; 12 pt leading; 12 pt before; 14 after 

B.5  Paragraphs, bullets, and list examples 

SIL Para 1 10 pt; regular; left; 12 pt leading; 0 pt before; 0 pt after 
SIL Para 2 Ditto, except .3″ left first line indent 
SIL Para Long Quote 9 pt; regular; .5″ left indent, .5″ right indent; 11 pt leading; 6 pt before; 6 

pt after 
SIL Para Long Quote 2 9 pt; regular; .5″ left indent, .5″ right indent; 11 pt leading; 0 pt before; 6 

pt after; .3″ first line indent 
SIL Line Spacer 5 pt; regular; left; single line space 
SIL List Bullet 1 10 pt; regular; no indent; .3″ hanging; 12 pt leading; 3 pt before; 3 pt after; 

no spelling, grammar check 
SIL List Bullet 2 Ditto, except .3″ left indent; .2″ hanging 
SIL List Bullet 3 Ditto, except .5″ left indent; .2″ hanging 
SIL List Examples (and) 
SIL List Item 1 

10 pt; regular; left; .3″ hanging; 12 pt leading; 3 
before, 3 after; no spelling or grammar check 

List item 
List examples 

SIL List Item 2 

(1)+tab; auto numbered 
1.+tab; auto numbered 
 

Ditto, except .3″ indent; .2″ hanging indent; manually numbered 
SIL List Item 3 Ditto, except .5″ indent; .2″ hanging indent; manually numbered 
SIL Reference Entry 
 

10 pt; left; .3″ hanging; 12 pt leading; 0 pt before; 6 pt after; 
alphabetical by author; for multiple entries by same author, enter name, 
(not line); chronological order, with earliest date first 
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B.6  Figures, tables, and maps 

SIL Figure Graphic Regular; centered; single line space; 10 pt before; 0 pt after 
SIL Figure Caption—below 

figure/graphic image 
10 pt regular; centered; 12 pt leading; 6 pt before, 10 pt after; no 
spelling, grammar check; keep lines together 

SIL Table Ctr Heading—above 
tables and maps 

10 pt; regular; centered; 12 pt leading; 10 pt before; 7 pt after; keep 
with next 

SIL Table Ctr Text 10 pt; regular; centered; 12 pt leading; 1 pt before; 1 pt after; keep 
lines together; keep with next 

SIL Table L Heading 1 10 pt; regular; left; 12 pt leading; 10 pt before; 7 pt after; keep with 
next 

SIL Table L Heading 2 10 pt; regular; .3″ indent; 12 pt leading; 10 pt before; 7 pt after; keep 
with next 

SIL Table L Text 10 pt; regular; left; 12 pt leading; 3 pt before; 3 pt after; keep lines 
together; keep with next 

SIL Table Text 9 pt 9 pt; regular; left; 11 pt leading; 2 pt before; 2 pt after; no spelling, 
grammar check 

SIL Table Text 9.5 pt 9.5 pt; regular; left; 11 pt leading; 2 pt before; 2 pt after; no spelling, 
grammar check 

B.7  Footnotes, table notes, and reference entries 

Footnote line Regular; left; 2 inches long 
Line continued Regular; margin to margin 
SIL Footnote Ref (referent (Character style) regular; superscript (follows text punctuation) 

for footnotes, table notes) Footnote appears at bottom of page; table note is at base of table 

SIL Footnote text 9 pt; regular; left; 11 pt leading (adjacent to note referent) 

B.8  Character styles 

In addition to the SIL Footnote Ref, the following are character style options: 
 

SIL Chr Bold Bold 
SIL Chr Data Regular; no spelling or grammar check 
SIL Chr Italic Italic 
SIL Chr Technical SMALL CAPS 
SIL Chr Underline Underline 
SIL Chr Vernacular Italic; no spelling, grammar check 
SIL Chr Vernac Emphatic Bold italic; no spelling, grammar check 
SIL Chr Vernac Underline Italic underline; no spelling, grammar check 
SIL Chr Raised 3 pt Raises character 3 pts 
SIL Footnote Ref Superscripts footnote or table note referent 
Hyperlink Links to target element. Font: Underline; Font color: Blue 

 
When the Word manuscript has been finalized, make a PDF. Then add bookmarks and the metadata. 
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Appendix C: Order of Parts for Print and Epub Publications 

The following list is based on the traditional arrangement, taken from The Chicago Manual of Style. 
Seventeenth edition (section 1.4). The order GPS follows agrees with CMOS, with a few additions  
(e.g., Endorsements, Series Page, Author Page) and excludes some parts that GPS doesn’t include  
(e.g., Epigraphs, Chronology). 
 

Blue indicates optional parts; bold indicates obligatory parts. Standard page placement is indicated 
at the right. 
 
Book front matter 

Endorsements (note: not listed in the TOC)         (first page[s] not marked) 
Half title page (no Author or Foreword writer’s name)     i (page number not marked) 
Series title, frontispiece, or blank       ii (page number not marked) 
Title page (with author’s and Foreword-writer’s full names)   iii (page number not marked) 
Copyright page        iv (page number not marked) 
Dedication          v 
Contents              v (or vii, if Dedication given) 
Illustrations (includes figures, photos, and maps)        (recto or verso) 
Tables              (recto or verso) 
Foreword              (recto) 
Preface              (recto) 
Acknowledgments            (recto) 
Introduction (or “How to Use this Book”)         (recto) 
Abbreviations             (recto or verso) 

Body text (beginning with Introduction or Chapter 1)     1 (recto) 
Back matter 

Appendix (or first, if more than one)         (recto) 
Second and subsequent Appendixes          (recto or verso) 
Notes               (recto) 
Glossary               (recto) 
References             (recto) 
(List of) Contributors           (recto) 
Index(es)                (recto) 
Series Page (not for stand-alone books or textbooks; not listed in TOC)   (recto) 
Author Page (is now GPS standard; not listed in the TOC)       (recto) 
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Appendix D: Editing Tips and Checks 

D.1  Front matter 

• Check that the author’s name is correct; full name, if known (no nicknames). 
• Check ISBN, LOC, ISSN, and series numbers. 
• Check that cover design has correct acknowledgment. 
• Make final check of headers: titles and page numbers, as compared with the table of contents (TOC). 

D.2  Text 

D.2.1 Overview 

• Check that section numbers and titles match the TOC. (Also that subheadings are consistent.) 
• In an abstract, an introduction, and an introductory sentence of a section, the list of topics should 

be in the same order as they are presented in the following discussion or subsections. 
• Is the logic of the relationship of one proposition, section or paragraph to another correct? 
• Check for collocational clashes; non sequiturs, clichés. 
• Avoid excessive redundancy: repetition of a word, phrase, or syntactic device. 
• Avoid mixed metaphors. 
• Correct errors in factual statements. 

D.2.2 Punctuation, symbols, and emphasis 

• Check punctuation with double quotation marks: the closing quotation mark should normally follow 
any other adjacent punctuation mark. Single quotation marks in a gloss precede punctuation. 

• Use a period at the end of sentence preceding an example, rather than a colon, whenever possible. 
• Avoid hyphenating prefixes such as non and co. 
• Be consistent in use of commas: 

• After e.g. and i.e. 
• Include in a series before and or or. 
• In a compound sentence with a change of subject, a comma occurs before the conjunction. 

• Do not use an ampersand (&); write out and—unless it is part of a proper name or trademark. 
• Make sure special symbols are clear; e.g., accent too close over vowel, null symbol is correct. 
• Check that italics, bold, small caps, and underlining are used consistently and not over used. 

D.2.3 Grammar 

• Check person and number agreement between subject and pronoun or verb.  
• This and that often need to have a noun following to avoid ambiguity. 
• Use etc. sparingly. Do not use etc. after for example (e.g.). 
• Check for inaccurate use of a word, e.g., a similar sounding word used in place of the correct one. 
• Contractions should be written out in text, e.g., I am, for I’m; They can be used in free translations. 
• Avoid overuse or redundant use of below, above, and following to point to an item before or after. 

D.2.4 Numbers, numerals, dates, and spelling 

• Numbered or lettered items in text have both an opening and closing parenthesis, i.e., (1) or (a), not 
1) or a); numbers are preferred. 
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• It is better not to begin a sentence with an example number, e.g., “(91) presents a…”). You can 
insert the word Example before the example number. 

• Note that bulleted paragraphs are often useful and keep a paragraph from being too heavy. 
However, do not list too many bulleted items together. 

• Page or date sequences are written out fully and require an en dash, not a hyphen, e.g., 95–96, not 
95–6. 

• Check for mistakes in dates, personal names, titles, and place names. 

D.3  Vernacular and interlinear text 

• Check that International Phonetic Alphabet (IPA) symbols are used consistently and correctly. 
• Vernacular capitalization and sentence punctuation decisions are left to the author. However, these 

are what is typical of vernacular texts: 
• Normally only proper names are capitalized and punctuation is not used. 
• Vernacular in the text is in italic type; in tables it is in regular type. 
• Avoid beginning a sentence with vernacular use (since these would normally be lowercase). 

• Gloss and vernacular 
• Make sure glosses are lined up with vernacular 
• There should be the same number of hyphens in the gloss as there are in the vernacular. 
• Where there is a two-word gloss for one-word vernacular, a period is used to combine the two 

words, and vice versa. 
• Free translation is typically marked with single quotation marks. 

D.4  Tables and figures 

• Make sure table headers are consistent (caps and bolding) throughout manuscript. Table headings 
are not followed by punctuation. 

• Check figure titles for consistency throughout manuscript. Figure captions end with a period. 

D.5  References 

• See references (section 12) for correct order and form of reference items. 
• Look for any missing reference information in the linguistics library or online at the SIL 

Bibliography, WorldCat, or Library of Congress sites; otherwise, ask the author to provide what is 
missing.
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Appendix E: Pre-compositing and Editing Checklist 

If unable to check off an item, please explain why, e.g., “Not relevant to this type of pub.” 
 

Title ___________________________________________________________ WO#_________ Author(s) _______________________________________ 
 

Pre-compositing 
 

General 
□ The SIL template is applied; attach if necessary, and tag with correct styles. 
□ “Page Layout” styles are correct: Size (Letter), Orientation (Portrait), Margins (each: 1″). 
□ All styles are applied consistently for paragraphs, lists, block quotes, figures, tables, character styles. 
□ A no-break space (Shift/Ctrl+spacebar) keeps corresponding items together on same line of text. 
□ Tested URLs to verify that links are active, unbroken. (If not active, make a track-change comment.) 
□ (Reminder: Never insert a Page Layout/Page Break/Section Break Continuous.) 
 (Comment: the compositor will paginate and will generate the front matter and contents sections.) 
 

Figures, tables, maps, charts, footnotes 
□ Check tables and maps (titled above) and figures (below) and correctly cross referenced in the text. 
□ Figures, tables, and maps are oriented and tagged with correct style—and are not hidden by text. 
□ Verify proper sequencing of figures, tables, maps, sections, and examples—no 1 or 1.1 without a 2. 
□ Lengthy- or interlinear-text examples are placed in a table. 
□ Columns are aligned, and formatting is consistent throughout the manuscript. 
□ Notes in tables and figures appear immediately beneath the table or figure—not at foot of the page. 
□ All footnote referents are tagged with “SIL Footnote Ref,” style, both in text and at its note.  
 
Copy/content editing (refer to the ILS Publications Style Sheet) 
 

Front matter and metadata 
□ Title, subtitle, author (no nicknames), publisher, and year are correct. 
□ Capitalization of titles, headings, and subheadings corresponds to ILS Pub Style Sheet standards.  
 

Text 
□ I read contents section and reviewed the ms. for parallel constructions, consistency, conciseness. 
□ If this is a book ms., who is the intended audience? ______________________________________________________________ 
□ If a book ms., what is the most compelling feature making it worth reading in your opinion? ________ 

___________________________________________________________________________________________________________________________________ 
□ Vocabulary is inoffensive; mention of religious affiliation and persuasion is as minimal as possible. 
□ Individuals, organizations, and cultures do not appear in an unnecessarily unfavorable light. 
□ People, named or recognizable in a photo, signed an Informed Consent (IC) permission form. 
□ Intellectual Property (IP) owners signed an SIL-GPS Permission Form for each IP item. 
□ Signed permission forms are filed in DaVinci/Shared Files/Customer Files. 
□ Author correctly attributed (acknowledged) IC and IP items in the text, on the map, or under it. 
□ Parentheses, braces, brackets, and quotation marks have both opening and closing marks. 
□ All quotes and apostrophes are “smart,”—except for special use of the prime-mark apostrophe (ꞌ). 
□ Em dash—no space before or after (European manuscripts use en dash – with spaces). 
□ En dash is used for number sequences, e.g., 5–10; page numbers are complete (25–27; not 25–7) 
□ Contractions are written out, e.g., “do not” for “don’t.” 
□ Abbreviations used, e.g., in the gloss line, match the abbreviations list. 
□ Items or places referred to in titles or text are indicated in the corresponding map, table or figure. 
□ Writing style is internally consistent, e.g., American vs. European spelling, en dash, serial commas. 
□ Turned on Word’s Review/Spelling checker; reviewed spelling, grammar, caps, punctuation. 
□ Cross-checked final text with the original PDF. Verified nothing is missing and style conforms. 
 

End matter 
□ Optional appendices precede references, and are titled using A, B, C, etc., rather than numbers. 
□ Each text citation has a matching reference entry, and each ref entry has a corresponding citation. 
□ This form is signed, dated, and filed—along with the time sheet—in DaVinci/Attachments. 
 

Name ____________________________________________________________________ Date _____________________________ 
 


	Contents
	Contents
	Abbreviations
	Abbreviations
	1 General approach
	1 General approach
	1.1 Communication with the author
	1.1 Communication with the author
	1.2 Content editing
	1.2 Content editing
	1.3 Copy editing
	1.3 Copy editing
	1.4 Compositing
	1.4 Compositing

	2 Headers and footers
	2 Headers and footers
	3 Front matter
	3 Front matter
	4 Text
	4 Text
	4.1 Headings and titles
	4.1 Headings and titles
	4.1.1 Part headings, chapter titles, and level one headings
	4.1.1 Part headings, chapter titles, and level one headings
	Print books
	Print books
	E-Books and papers
	E-Books and papers

	4.1.2 Second, third, and fourth level headings
	4.1.2 Second, third, and fourth level headings

	4.2 Paragraph styles
	4.2 Paragraph styles
	4.2 Paragraph styles
	4.3 Bulleted lists, example lists, and item lists
	4.3 Bulleted lists, example lists, and item lists
	4.4 Citation and parenthetic information
	4.4 Citation and parenthetic information
	4.5 Footnotes
	4.5 Footnotes

	5 Punctuation
	5 Punctuation
	5.1 Quotation marks
	5.1 Quotation marks
	5.2 Commas
	5.2 Commas
	5.3 Ellipses and spacing
	5.3 Ellipses and spacing
	5.3 Ellipses and spacing
	5.4 Hyphens, em dash, and en dash
	5.4 Hyphens, em dash, and en dash
	5.4.1 Hyphens
	5.4.1 Hyphens
	5.4.2 Em dash
	5.4.2 Em dash
	5.4.3 En dash
	5.4.3 En dash


	6 Numbers, numerals, dates, and spelling
	6 Numbers, numerals, dates, and spelling
	6 Numbers, numerals, dates, and spelling
	7 Italics, bolding, and underlining
	7 Italics, bolding, and underlining
	8 Capitalization, abbreviation, and acronyms
	8 Capitalization, abbreviation, and acronyms
	8.1 Capitalization of titles
	8.1 Capitalization of titles
	8.2 Abbreviations
	8.2 Abbreviations
	8.3 Acronyms and abbreviation with full and small caps
	8.3 Acronyms and abbreviation with full and small caps
	8.3.1 Full caps
	8.3.1 Full caps
	8.3.2 Full or small caps
	8.3.2 Full or small caps
	8.3.3 Small caps
	8.3.3 Small caps


	9 Vernacular, glosses, and interlinear text
	9 Vernacular, glosses, and interlinear text
	9.1 Vernacular, IPA script, and biblical languages
	9.1 Vernacular, IPA script, and biblical languages
	9.2 Glosses and free translation in interlinear text
	9.2 Glosses and free translation in interlinear text

	10 Tables, maps, and figures
	10 Tables, maps, and figures
	11 Appendices
	11 Appendices
	12 References
	12 References
	12.1 Name of authors, editors, translators, and compilers
	12.1 Name of authors, editors, translators, and compilers
	12.1.1 Authors
	12.1.1 Authors
	12.1.2 Editors, translators, and compilers
	12.1.2 Editors, translators, and compilers

	12.2 Date of publication
	12.2 Date of publication
	12.3 Titles
	12.3 Titles
	12.3 Titles
	12.3.1 Book titles
	12.3.1 Book titles
	12.3.2 Series titles
	12.3.2 Series titles
	12.3.3 Titles of articles and published papers
	12.3.3 Titles of articles and published papers
	Articles in a journal
	Articles in a journal
	Articles in collections and proceedings
	Articles in collections and proceedings
	12.3.4 Book reviews
	12.3.4 Book reviews

	12.4 Place of publication and publisher
	12.4 Place of publication and publisher
	12.5 Unpublished papers, dissertations/theses, manuscripts
	12.5 Unpublished papers, dissertations/theses, manuscripts
	12.6 References from a website
	12.6 References from a website

	Appendix A: SIL Template Guidelines
	Appendix A: SIL Template Guidelines
	SIL International® (SIL Front Publisher-Year) 2019
	SIL International® (SIL Front Publisher-Year) 2019
	Series Editor
	Series Editor
	Volume Editor
	Volume Editor
	Managing Editor
	Managing Editor
	Compositor
	Compositor
	A.1  Print book headings and chapter titles
	A.1  Print book headings and chapter titles
	5 Sample Title of Chapter Five for a Print Book
	5 Sample Title of Chapter Five for a Print Book
	5.1 Sample first level heading of chapter five for a print book
	5.1 Sample first level heading of chapter five for a print book
	5.1.1 Sample second level heading of chapter five for a print book
	5.1.1 Sample second level heading of chapter five for a print book

	A.2  E-Book and paper headings and chapter titles
	A.2  E-Book and paper headings and chapter titles
	1 First level heading (SIL Heading 1)
	1 First level heading (SIL Heading 1)
	1.1 Second level heading (SIL Heading 2)
	1.1 Second level heading (SIL Heading 2)
	1.1.1 Third level heading (SIL Heading 3)
	1.1.1 Third level heading (SIL Heading 3)


	A.3  Text: Paragraph styles (and the line spacer)
	A.3  Text: Paragraph styles (and the line spacer)
	A.4  Character styles
	A.4  Character styles
	A.5  Bullet lists, example lists, and interlinear text
	A.5  Bullet lists, example lists, and interlinear text
	A.6  Tables
	A.6  Tables
	A.6.1 Table left headings and table left text
	A.6.1 Table left headings and table left text
	A.6.2 Table center heading and table center text; notes in a table
	A.6.2 Table center heading and table center text; notes in a table
	.6.3 Small and tiny text options for tables
	.6.3 Small and tiny text options for tables

	A.7  Footnotes
	A.7  Footnotes
	A.7  Footnotes
	A.8  Figures and graphics
	A.8  Figures and graphics
	A.9  Appendices and references
	A.9  Appendices and references
	Appendix B: Layout Specifications
	Appendix B: Layout Specifications
	B.1  Basic setup
	B.1  Basic setup
	B.2  Page numbering and titles in headers and footers
	B.2  Page numbering and titles in headers and footers
	B.3  Front matter and end matter
	B.3  Front matter and end matter
	B.3.1 Title page (papers, e-Books)
	B.3.1 Title page (papers, e-Books)
	B.3.2 Verso page
	B.3.2 Verso page
	B.3.3 Contents
	B.3.3 Contents

	B.4  Headings
	B.4  Headings
	B.5  Paragraphs, bullets, and list examples
	B.5  Paragraphs, bullets, and list examples
	B.6  Figures, tables, and maps
	B.6  Figures, tables, and maps
	B.7  Footnotes, table notes, and reference entries
	B.7  Footnotes, table notes, and reference entries
	B.8  Character styles
	B.8  Character styles
	Appendix C: Order of Parts for Print and Epub Publications
	Appendix C: Order of Parts for Print and Epub Publications
	Appendix D: Editing Tips and Checks
	Appendix D: Editing Tips and Checks
	D.1  Front matter
	D.1  Front matter
	D.2  Text
	D.2  Text
	D.2.1 Overview
	D.2.1 Overview
	D.2.2 Punctuation, symbols, and emphasis
	D.2.2 Punctuation, symbols, and emphasis
	D.2.3 Grammar
	D.2.3 Grammar
	D.2.4 Numbers, numerals, dates, and spelling
	D.2.4 Numbers, numerals, dates, and spelling

	D.3  Vernacular and interlinear text
	D.3  Vernacular and interlinear text
	D.4  Tables and figures
	D.4  Tables and figures
	D.5  References
	D.5  References
	Appendix E: Pre-compositing and Editing Checklist
	Appendix E: Pre-compositing and Editing Checklist

